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ARCGIS 10.5 

CARTOGRAFÍA 

I. REPRESENTACIÓN DE LA TIERRA  

 

El presente material tiene como objeto proporcional los conocimientos básicos de los 
parámetros cartográficos  y Sistemas de Información Geográfica SIG. 

  

1.1. Forma de la tierra 

 

Elipsoide 

 

La tierra no es redonda, su figura se asemeja a una naranja o una “esfera achatada por los polos”, y 

no existe figura geométrica alguna que la represente, debido a las irregularidades existentes. 

Estas  irregularidades de la tierra con detectables y no extrapolables a todos los puntos  simétricos 

de la tierra, debido a que no existe un único modelo matemático que represente toda la superficie 

terrestre, por lo cual cada continente, nación, etc., emplean un modelo matemático distinto que se 

adapte mejor a la forma de la tierra en sus zonas. 

Por tanto, cada país ha escogido un elipsoide como un “Elipsoide de Referencia”. Es decir como 

la figura de dimensiones y orientación fija con respecto a la tierra y cuya superficie puede ser 

empleada como superficie de referencia para trabajos topográficos. 

 

El elipsoide es el elemento de representación de la tierra, y es el resultado de revolucionar una 

elipse sobre su eje. 

Elipsoide es la superficie generada por la rotación de una elipse alrededor de su semieje menor. Es 

deseable que esta se aproxime lo más posible a la forma de la tierra, en ella se hacen los cálculos 

geodésicos. 
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Es la figura geométrica generada por la rotación alrededor de su eje menor (P,P’). Ésta se aproxima 

más a forma de la tierra porque es achatada en los polos y abultada cerca del ecuador (plano 

ecuatorial EA E'A'). El Elipse gira sobre su eje menor P, P' (SILVA, R. 2004). 

 

El elipsoide se define matemáticamente en función de los siguientes parámetros: 

- Radio mayor(a) y radio menor (b) del elipsoide 

- Aplastamiento del elipsoide (1/f=1-(b/a)) 

 

 

EL Ecuador actualmente utiliza el Elipsoide CRS 80 para el Sistema de Referencia con SIRGAS 

Antes utilizaba el Elipsoide Internacional ubicado en punta Canoa, Venezuela, para el Sistema de 

Referencia PSAD 56 
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Geoide 

 

El geoide es una superficie equipotencial del campo gravitatorio terrestre, definido por el nivel 

medio del mar, la vertical de esta superficie coincide en todos los casos con la dirección de la 

plomada. 

 

 
El geoide es una figura cuya forma es la de una superficie equipotencial. Es decir en donde la 
gravedad terrestre es la misma en cada uno de los puntos que la forman y esta gravedad es 
perpendicular al geoide. Esta superficie es más lisa que la superficie de la tierra pero presenta 
irregularidades a diferencia del elipsoide como podemos observar en el gráfico (SILVA, R. 2004).  
Entonces las características más importantes del geoide son:  
 

• Gravedad terrestre es la misma en cualquier punto.  

• La dirección de la gravedad es perpendicular al Geoide.  

 

 
 
 

Datum 

 

La tangencia del geoide y del elipsoide que ha sido definido con orientación y posición así como en 

tamaño y forma, es el punto llamado Datum geodésico, que frecuentemente se lo designa como 

punto de partida. 

 

Entonces se define al Datum como el punto tangente al elipsoide y al geoide, donde ambos 

coinciden 
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Cada Datum está compuesto por: 

Un elipsoide definido por a, b, aplastamiento 

Un punto llamado “Fundamental” en el que el elipsoide y la tierra son tangentes. Este punto 

fundamental se define por sus coordenadas geográficas longitud y latitud, además del acimut de 

una dirección con el origen en el punto fundamental. 

 

Datum de geodesia son puntos de coincidencia del Geoide y el Elipsoide 
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De debe recalcar que la Geodesia es la ciencia que estudia el tamaño y forma de la tierra 

Tangente es la recta que intercepta a la circunferencia en un solo punto, llamado punto tangencia. 

 

 

En geodesia hay que considerar dos tipos de datums: Locales (horizontal y vertical) y de 

Satélite. 

 

Datum horizontales locales 

 

El Datum local Horizontal consta de un punto de partida en donde la desviación de la vertical tiende 

a cero (para el caso del Ecuador es la Canoa ( Venezuela), un elipsoide donde se realizan los caculos 

(para nuestro país es el de Hayford), sistemas de coordenadas (geográficas y UTM), el azimut de una 

línea, que nos da la dirección con la cual se realiza el cálculo, más el radio ecuatorial (semieje mayor) 

y el achatamiento, necesarios para definir el elipsoide de referencia. Un cambio de valor en 

cualquiera de los parámetros definidos, hará cambiar el Datum y consecuentemente cambiará 

también las coordenadas de todos los puntos basados en el datum. 
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Datum verticales locales 

 

El Datum local vertical, al que se refieren las elevaciones de los puntos, es generalmente la superficie 

del nivel medio del mar (Estación mareográfica de La Libertad - Provincia del 

Guayas, - Ecuador 1959. 

 
Cuando los puntos son lo más tangente posible al nivel medio del mar. 

 
 

 
Para pasar de una referencia a otra es necesario usar como origen un punto de coincidencia del 

elipsoide con el geoide “datum horizontal”. De acuerdo al datum que se adopte implica la adopción 

de un determinado elipsoide de referencia que más convenga al territorio del país 

 

 

Datum Satélite 

 

Los datums de satélite se definen de una manera totalmente diferente a los datums locales, pues 

éstos se refieren solamente a una parte muy pequeña de la superficie terrestre y no tienen relación, 

o, en el mejor de los casos, sólo están levemente relacionados con el centro de la masa terrestre, el 

geocentro.  
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El sistema de referencia para el satélite se define por el sistema en el cual están dadas las efemérides 

del satélite o datos orbitales. Estos parámetros orbitales se basan en las coordenadas adoptadas 

por un número de estaciones de rastreo, un modelo geopotencial adoptado para el campo 

gravitacional terrestre y constantes previamente definidas. Un elipsoide está normalmente 

asociado con un datum satelitario, de tal forma que las posiciones pueden ser mostradas tanto en 

coordenadas geográficas como en cartesianas. Este elipsoide es derivado mediante un ajuste de 

mínimos cuadrados. 

 

 
Están definidos mediante las orbitas de los satélites, se basan en las coordenadas.  

Los datums satelitales son geocéntricos y se les llama los elipsoides GPS:  

Word Geodetic System 1960 (WGS60)  

Word Geodetic System 1966 (WGS66)  

Word Geodetic System 1973 (WGS72)  

Word Geodetic System 1984 (WGS84)  

 

Llamado también Elipsoide GPS  

Actualmente el Datum con el cual trabaja el Ecuador es el WGS84  

Geocéntrico: Es el centro de la tierra o relatico a él. 

 

1.2. Proyecciones cartográficas 

 

La proyección cartográfica o proyecciones geográficas es un sistema de representación gráfico que 

establece una relación ordenada entre los puntos de la superficie curva de la Tierra y los de una 

superficie plana (mapa). Estos puntos se localizan auxiliándose en una red de meridianos y paralelos 

en forma de malla. 

La única forma de evitar las distorsiones de esta proyección sería usando un mapa esférico pero, en 

la mayoría de los casos, sería demasiado grande para que resultase útil. 

En un sistema de coordenadas proyectadas, los puntos se identifican por coordenadas x, y en una 

malla con su origen en el centro de la malla. 

En cambio, las coordenadas  geográficas (longitud y latitud) se caracterizan por no estar 

proyectadas. 

Las representaciones planas de la esfera terrestre se llaman mapas, y los encargados de 

elaborarlos o especialistas en cartografía se denominan cartógrafos. 
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Fuente: Revista Geográfica Digital, IGUNNE, 2010 

 

Propiedades de las proyecciones cartográficas 

 

En cambio, las coordenadas  geográficas (longitud y latitud) se caracterizan por no estar 

proyectadas. 

La clasificación de las proyecciones está en función de su principal propiedad, o el aspecto de la 

retícula: tangente, secante, transversa u oblicua; o por la relación entre la superficie terrestre y el 

mapa:  

• Proyecciones conformes, si conserva los ángulos, si no lo conserva se dice que la proyección 

tiene anamorfosis angular 

• Proyecciones equivalentes, si mantiene la superficie, cuando no cumplen tiene anamorfosis 

superficial 

• Proyecciones equidistantes,  conserva las distancias, en todo el mapa no se cumple esta 

propiedad, pero debido a la escala, se puede considerar que las deformaciones son tan 
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pequeñas que se admiten como tolerables. Cuando no se cumple esta propiedad tiene 

anamorfosis lineal. 

Deformaciones 

  

Cualquier sistema de proyección deforma la realidad, ya sea en la forma, en los tamaños o en las 

distancias entre lugares., así podemos encontrar proyecciones: 

• Proyecciones conformes: que representan la esfera respetando la forma, pero no el tamaño 

• Proyecciones equivalentes: que respetan las dimensiones de las áreas pero no sus formas 

• Proyecciones equidistantes: que mantienen la distancia real entre los distintos puntos del 

mapa 

 

Una buena proyección cartográfica debe tener dos características: que conserve las áreas 

(equivalencia) y que conserve los ángulos (conformidad). No es posible tener ambas características 

a la vez, por lo que hay que buscar soluciones intermedias. Cuando una proyección conserva los 

ángulos de las figuras geométricas se dice que es ortomórfica o conforme, pero dichas proyecciones 

no conservan las áreas. 

 

Tipo de proyecciones cartográficas 

 

Al ser la Tierra esférica, no hay forma de representarla directamente sobre un plano, ya que la 

esfera es una figura geométrica que no se puede desarrollar (transformar en plano, como si lo 

pueden hacer los conos los cilindros, los cubos...). Para su representación en el mapa, se necesitan 

de los denominados sistemas de proyección, que son los métodos que permiten trasladar la 

superficie esférica terrestre a un plano  o a otra superficie que pueda desarrollarse (un cilindro o un 

cono). 

 

Dependiendo de la zona de donde se va a realizar el mapa y cuál sea el centro del mapa, se distingue 

las proyecciones: 

• Polares cuyo centro de uno de los polos 

• Ecuatoriales cuyo centro es la intersección ente la línea del Ecuador y un meridiano 

• Oblicuas o inclinadas cuy centro es cualquier otro punto. 

Se distinguen tres tipos de proyecciones básicas: cilíndricas, cónicas y azimutales 
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Tarea de consultas de estudiantes: 

• Proyección cilíndrica 

• Proyección cónica 

• Proyección azimutal, cenital o polar 

• Proyecciones modificadas 
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1.3. Sistema de coordenadas 

 

 

Es el conjunto de elementos lineales o angulares y elementos geométricos fijos que nos permite 

localizar o ubicar matemáticamente la posición de un punto sobre el plano o sobre la tierra en forma 

absoluta o relativa mediante líneas de referencias reconocidas internacionalmente. Existen 

diferentes sistemas de coordenadas:  

Coordenadas geodésicas  

Coordenadas astronómicas  

Coordenadas cartesianas  

Coordenadas geográficas 

 

 
La cartografía ha simplificado el problema de localización de puntos o mediciones realizadas 

directamente en la superficie terrestre proyectándolas luego sobre un plano mediante la creación y 

definición de un sistema de ejes de coordenadas sobre la tierra. 

 

 

Coordenadas geográficas 

 

Nos permite expresar en grados, minutos y segundos la ubicación absoluto de un punto sobre el 

terreno o sobre el terreno o sobre el mapa, carta o plano mediante un paralelo o latitud y un 

meridiano o longitud. 

 

El sistema de coordenadas geográficas es un sistema de referencia que utiliza las dos coordenadas 

angulares latitud (norte o sur) y longitud (este u oeste) para determinar las posiciones de los puntos 

de la superficie terrestre. Estas dos coordenadas angulares medidas desde el centro de la Tierra son 

de un sistema de coordenadas esféricas que está alineado con su eje de rotación. Estas coordenadas 

se suelen expresar en grados sexagesimales: 

La latitud mide el ángulo entre cualquier punto y el ecuador. Las líneas de latitud se llaman paralelos 

y son círculos paralelos al ecuador en la superficie de la Tierra. La latitud es la distancia que existe 

entre un punto cualquiera y el Ecuador, medida sobre el meridiano que pasa por dicho punto.  

• Todos los puntos ubicados sobre el mismo paralelo tienen la misma latitud. 

• Aquellos que se encuentran al norte del Ecuador reciben la denominación Norte (N). 

• Aquellos que se encuentran al sur del Ecuador reciben la denominación Sur (S). 

• Se mide de 0º a 90º. 

• Al Ecuador le corresponde la latitud de 0º. 

• Los polos Norte y Sur tienen latitud 90º N y 90º S respectivamente. 
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La longitud mide el ángulo a lo largo del ecuador desde cualquier punto de la Tierra. Se acepta que 

Greenwich en Londres es la longitud 0 en la mayoría de las sociedades modernas. Las líneas de 

longitud son círculos máximos que pasan por los polos y se llaman meridianos.  

• Todos los puntos ubicados sobre el mismo meridiano tienen la misma longitud. 

• Aquellos que se encuentran al este del Meridiano Cero reciben la denominación Este (E). 

• Aquellos que se encuentran al oeste del Meridiano Cero reciben la denominación Oeste (O). 

• Se mide de 0º a 180º. 

• Al meridiano de Greenwich le corresponde la longitud 0º. 

Combinando estos dos ángulos, se puede expresar la posición de cualquier punto de la superficie 

de la Tierra. 
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Coordenadas cartesianas 

 

 

Mientras que en el GIS tradicional es útil de muchas formas mostrar datos,  eso satisface nuestro 

sentido visual de profundidad. Usted puede obviar este déficit con ArcGIS 3D Analyst, lo cual le 

permite que la vista interactúe y analice sus datos dentro de un ambiente tridimensional.  

(Fuente:Nexthttp://training.esri.com/Courses/Learn3D/M1/module introduction18070.cfm) 

  

http://training.esri.com/Courses/Learn3D/M1/module_introduction18070.cfm
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II. FORMATOS DE ALMACENAMIENTO DE DATOS ESPACIALES 

 

El presente material tiene como objeto proporcional los conocimientos básicos de los 
parámetros cartográficos  y Sistemas de Información Geográfica SIG. 

  

1.4. Raster 

 
Captura información mediante los medios: Scanners, satélite, fotografía aérea, cámaras de video 

entre otros. Son fotografías, imágenes digitales capturadas por satélites (LandSat, Spot) o 

información digital de un mapa. Trabaja con celdas de igual tamaño que poseen un valor; el tamaño 

de la celda define el nivel de detalle de la información. 

 

 
Este modelo está orientado para representar fenómenos tradicionalmente geográficos que varían 
continuamente en el espacio; como la pendiente del terreno, altitud o precipitación. El modelo 
raster también es llamado imagen. 

 
 
En este modelo, el espacio geográfico es dividido en sectores de forma regular denominada 
comúnmente píxel. De esta forma se establece una malla coordenada (con el origen en la esquina 
superior izquierda) de píxeles en la que cada píxel va a tomar el valor de la información geográfica 
que se encuentre en la posición del píxel.  
Cuanto más pequeño sea el tamaño de píxel más precisa será la representación de la información 
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a) JPEG  
Es el poder ajustar el grado de compresión. Si especificamos una compresión muy alta se perderá 
una cantidad significativa de calidad, pero obtendremos ficheros de pequeños tamaños. Con una 
tasa de compresión baja obtenemos una calidad muy parecida a la del original, y un fichero mayor. 
Finalmente es el usuario quien controla la calidad de la imagen mediante la selección de compresión 
deseada. El formato de archivos JPEG se abrevia frecuentemente JPG debido a que algunos sistemas 
operativos solo aceptan tres letras de extensión.  
b) TIFF  
 
Es un formato creado por la empresa Aldus y Microsoft que puede almacenar imágenes en blanco 
y negro (1bits), tonos de grises (4, 8, 16, 24, o 32 bits), seudo color (4, 8 o 16 bits) y color verdadero 
(24bits). Mantiene la calidad de la imagen pero el archivo es muy pesado. 
 
 
c) IMG  
Es el archivo nativo del programa ERDAS. 
 

1.5. Formato vectorial 

 

El formato vectorial (shape) puede ser creado a partir de fuentes de información espacial existente, 

o pueden ser generados desde ArcGIS, donde podemos añadir elementos. 



MANUAL DE EJERCICIOS ARCGIS 10.5 
 

Manual  de trabajo práctico con ArcGis 10.5  
Ing. Anabel Pérez  
  18 
 

 

 
La composición de una cobertura vectorial en ArcGIS consta de tres o más archivos con el mismo 
nombre, pero con extensiones diferentes:  
Ejemplo:  

• Dbf: tabla de atributos 

• Shp: datos espaciales geometría 

• Shx: índice de datos espaciales 

Ejemplo: shape de geo pedología 

 

Este tipo de dato tiene gran rapidez en despliegue y visualización, además que pueden ser editados 

(modificados), los objetos de una cobertura vectorial pueden estar representados: puntos, línea y 

polígonos. 

Punto  

 
Objeto representado como coordenadas (X, Y, Z). No presenta dimensiones. Ejemplo: localización 

de un árbol, poste y dependiendo de la escala se puede representar caseríos, ciudades, entre otros. 
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Línea  

 
Objeto construido por una cadena de puntos. Contiene por lo menos de un punto de inicio y un 

punto final. Posee longitud. Ejemplo: para representar caminos, ríos, quebradas, etc. 

Polígono  

 
Conjunto de puntos, donde el punto de inicio es igual al punto final, formando así una figura 

geométrica cerrada con un interior y un exterior. Es decir debe presentar como mínimo tres vértices. 

Posee como atributos perímetro y área. Ejemplo: Una parcela muestreo, cuenca hidrográfica, un 

rodal semillero 

 

III. ARCGIS DESKTOP 

 
Es una arquitectura integrada de los productos SIG de la casa ESRI (Figura 1) que incluye ArcReader, 
ArcView, ArcEditor y ArcInfo. Estos cuatro productos comparten una misma interface, por lo tanto 
tienen el mismo aspecto y trabajan de la misma manera. La diferencia está en la funcionalidad de 
cada uno de estos productos, que va desde la más básica ArcReader hasta la de altas prestaciones 
de ArcInfo (ORDUÑA, 2007). 
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Ilustración 1. Esquema de la Arquitectura de ArcGIS 

 

1.6. ArcGIS 

 
Es un sistema de información geográfica, el cual posee una interface gráfica de usuario, de manejo 

sencillo con el ratón, posibilita cargar con facilidad datos espaciales y taburales para ser mostrados 

en forma de mapas, tablas y gráficos, también provee las herramientas necesarias para consultar y 

analizar los datos y presentar los resultados como mapas con calidad de presentación. Algunos 

ejemplos de lo que se puede obtener es cartografía temática, creación y edición de datos, análisis 

espacial, geo codificación de direcciones, etc. ArcGIS se compone de tres aplicaciones que están 

incluidas en ArcInfo, ArcEditor y ArcView, las cuales son ArcMap, ArcCatalog y ArcToolbox (ORDUÑA, 

2007). 

 

1.7. ArcInfo 

 
Es el producto funcionalmente más rico en la familia de ArcGIS. Incluye toda el potencial que puede 
dar ArcView y ArcEditor, de forma adicional ArcInfo añade el entorno de geoprocesamiento de 
ArcGIS Desktop, más de 100 herramientas nuevas válidas para trabajar con cualquier formato 
vectorial de los soportados por ArcGIS, y unas 50 herramientas específicas para formato cobertura. 
Dispone de funcionalidades de conversión de datos a otros formatos y sistemas de proyección, así 
como toda la funcionalidad aportada por el entorno de comandos de ArcInfo Workstation 
(ORDUÑA, 2007).  
Las organizaciones utilizan el poder de ArcInfo todos los días para crear, editar y analizar sus datos 
con el fin de tomar mejores decisiones, más rápido. ArcInfo es el estándar de facto para el SIG.  
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Con ArcInfo, puede: 

•  Realizar operaciones avanzadas de datos de SIG de análisis y modelado.  

•  Disfruta de herramientas diseñadas para el análisis de superposición, análisis de 
proximidad, análisis de superficie, y el procesamiento de la trama y la conversión.  

•  Publicar y convertir los datos en muchos formatos.  

•  Crear y gestionar bases de datos geográficas personal, bases de datos geográficas 
multiusuario, y conjuntos de datos de características.  

•  El uso de alta gama herramientas de cartografía para generar calidad profesional, listos los 
mapas de la publicación.  

•  Diseño personalizado y símbolos lugar sofisticado de anotación y las etiquetas en sus 
mapas.  

 

1.8. ArcEditor 

 
Diseñado principalmente para crear y editar geodatabases. Se puede crear y modificar bases de 

datos y esquemas de bases de datos para ficheros shape, coberturas, geodatabases personales, y 

corporativas o multiusuario; así como la posibilidad de implementar topología basada en reglas. Sin 

embargo, el ArcEditor no va a ser utilizado durante la producción del nuevo mapa de cobertura 

(ORDUÑA, 2007). 

 

1.9. ArcView 

 
Incorpora funciones avanzadas de visualización, análisis y consulta de datos, así como la capacidad 

de crear y editar datos geográficos y alfanuméricos. Asimismo, contiene ArcMap, ArcCatalog y 

ArcToolbox (ORDUÑA, 2007). 

 

1.10. ArcMap 

 
Permite realizar mapas a partir de capas o datos espaciales, elegir colores y simbología, interrogar 

a las bases de datos, analizar relaciones espaciales y diseñar mapas o salidas impresas. La interfaz 

de ArcMap se compone de una tabla de contenidos donde se listan todas las capas que forman el 

mapa, una ventana donde se muestra el mapa, y una serie de menús y herramientas para trabajar 

con las capas y mapas (ORDUÑA, 2007). 
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1.11. ArcCatalog 

 
Permite manipular y acceder la información geográfica de un modo fácil. Se puede agregar las 
conexiones de la información geográfica con que se está trabajando al Catálogo; también, se pueden 
conectar los fólder con los discos locales y compartir fólderes y bases de datos que están disponibles 
en la red de trabajo.  
Después de construir el Catálogo, es posible observar diferentes vistas para ver las fuentes de 
información geográfica que están disponibles con su respectiva conexión y explorar los contenidos 
individuales de las fuentes de datos. Es permisible explorar toda la información del mismo modo en 
que fue guardada. Además, el programa posee herramientas para organizar y darle mantenimiento 
a la información.  
Los datos son presentados en una estructura de árbol y a la derecha de la pantalla se pueden 

observar los archivos espaciales en miniatura, por ejemplo se pueden previsualizar las capas de 

forma ampliada y obtener los datos relativos al origen y contenidos de ese archivo (ORDUÑA, 2007). 

 

1.12. ArcToolbox 

 
Permite convertir los datos espaciales de un formato a otro, así como introducir un sistema de 

referencia o cambiar proyecciones de los datos. Las herramientas se encuentran organizadas 

temáticamente y mediante el empleo de intuitivos asistentes, permiten realizar dichas funciones de 

forma sencilla e inmediata; su poder radica en funciones para análisis espacial (ORDUÑA, 2007). 
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EJERCICIOS ARCGIS 10 
 

TEMA 1 

INTRODUCCIÓN A ARCCATALOG Y ARCMAP 

 
EJERCICIO 1A – INTERFAZ DE ARCCATALOG 
 

ArcCatalog es el módulo de ArcGIS diseñado para explorar y administrar los datos SIG gestionados por la 

aplicación. En este ejercicio se explorarán los diferentes tipos de archivos que se pueden almacenar y leer con 

ArcGIS, y se aprenderá a trabajar con las principales funcionalidades soportadas por ArcCatalog. 

SUMARIO 
  
1. Iniciar ArcCatalog y crear una conexión al directorio del curso.  
2. Explorar los archivos.  
3. Explorar los metadatos.  
4. Administrar los datos.  
5. Crear un nuevo archivo.  
 

1. Iniciar ArcCatalog y crear una conexión al directorio del curso.  
Los datos correspondientes a los ejercicios que integran el curso se han almacenado en el sistema en la carpeta 
c: \Cartografía Organización. Para acceder con agilidad a dicha información desde las aplicaciones que 
integran ArcGIS es necesario crear una conexión al directorio indicado. Para ello, haga doble “clic” con el 
botón izquierdo del ratón sobre el icono de la aplicación ArcCatalog o, desde el menú Inicio de Windows, 
seleccione Programas ► ArcGIS ► ArcCatalog. Seguidamente, haga “clic” con el botón izquierdo del ratón 
en el botón Connect to Folder para conectar el directorio.  
 
 
En el cuadro de diálogo desplegado, busque el directorio del curso: c: \ Cartografía Organización. Haga “clic” 
en Aceptar. Observe que al final de la lista de directorios aparece la nueva conexión creada. No elimine la 
conexión, ya que necesitará utilizarla durante todo el desarrollo del curso.  
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Si lo desea, puede editar el nombre de este directorio y cambiarlo por uno más corto; para ello, haga “clic” 
con el botón izquierdo del ratón sobre el nombre actual y cámbielo por uno de su conveniencia; se sugiere 
CURSO ARCGIS 10 
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2. Explorar los archivos  
Ahora puede acceder al directorio del curso y explorar los archivos que contiene. Haga “clic” con el botón 
izquierdo del ratón en el signo más (+) ubicado al lado izquierdo del nombre del directorio y observe que, en 
la ventana de la derecha, se despliega la lista de carpetas contenidas en el directorio.  
 
Explore la información de Cartografía Organización 
 
Haga “clic” en el signo más (+) situado a la izquierda de la carpeta denominada Am_Areas Protegidas para 
desplegar la lista de archivos que contiene. A continuación, seleccione un archivo “shape” (icono cuadrado 
verde ) y marque la opción Preview (Vista Previa).  
 

 
 
En la parte inferior de la aplicación, cambie la opción Geography (Geografía) por Table (Tabla), para desplegar 
la tabla de atributos perteneciente a este archivo.  
 

 

 
 

Haga “clic” con el botón izquierdo del ratón en el signo menos (-), situado a la izquierda de la carpeta 
denominada Cartografía Organización para cerrar la lista de archivos desplegada. Pulse a continuación el 
signo más (+) situado a la izquierda de la carpeta denominada Am_Areas Protegidas . Haga “clic” en el signo 
más (+) ubicado a la izquierda del archivo  Am_Socio Bosque   y repita la operación para visualizar el contenido 
del archivo  
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Cambie la opción Geography (Geografía) por Table (Tabla), para desplegar la tabla de atributos perteneciente 
a este archivo. La estructura y los datos almacenados en esta tabla se corresponden con la configuración 
habitual que presentan los archivos “CAD”.  

 

 
Cierre la carpeta Cartografía Organización  haciendo “clic” sobre el signo menos (-), situado a la izquierda de 
la carpeta.  
Abra nuevamente la carpera y Haga “clic” posteriormente con el botón izquierdo del ratón sobre el archivo 
“raster” remuestreada 1m. Se trata de una imagen “Ortofoto” que cubre parte de la provincia de Tungurahua.  
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Haga “clic” con el botón derecho del ratón sobre el nombre de este archivo y marque la opción Properties 
(Propiedades). En la pantalla desplegada se muestran las propiedades de la imagen: número de bandas, 
tamaño de celda, extensión espacial y referencia espacial, entre otras. Recorra el contenido de esta pantalla 
y, cuando termine, presione el botón Aceptar, para cerrarla  
 

  

 
2. Explorar los metadatos  

 
La metadatos son los datos que documentan la información cartográfica almacenada en el sistema. Esta 
información incluye la descripción del contenido del archivo, la denominación del proyecto para el cual fue 
creado, la fecha de elaboración, la proyección del archivo, el autor de la fuente original, etc.  
 
En la carpeta Cartografía organización haciendo “clic” en el signo menos (-) situado a la izquierda de ésta 
carpeta. Pulse después el signo más (+) situado a la izquierda de la carpeta denominada Pueblos. A 
continuación, haga “clic” con el botón izquierdo del ratón en el archivo “shape” denominado Pueblo_Kañari  
y cambie la vista a la opción Description (Metadatos).  
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Haga “clic” en el botón Edit metadata (Editar metadatos) para explorar las pantallas de entrada de metadatos.  

 

 

Las casillas que presentan textos descriptivos resaltados en color rojo indican que se trata de campos que 
deben cumplimentarse obligatoriamente. Haga “clic” en las restantes pestañas del cuadro de diálogo para 
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explorar su contenido. Vuelva a la pestaña General (General) y rellene los campos según se indica a 
continuación  

 

 

Presione Save para guardar los cambios. Observe que los textos incorporados se muestran en la ventana de 
la vista Metadatos.  
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4. Administrar los archivos  
 En la Tabla de Contenido (sector izquierdo de la pantalla), haga “clic” con el botón derecho del ratón sobre 

el archivo “shape” (icono cuadrado verde ) denominado Am_Geomorgologia, y observe las opciones 
disponibles para administrar el archivo: Copy (Copiar), Delete (Borrar), Rename (Renombrar), Create Layer… 
(Crear Capa…), Export (Exportar) y Properties (Propiedades). Haga “clic” en la opción Properties 
(Propiedades) y, en la pantalla desplegada, seleccione la pestaña XY Coordinate System (Sistema de 
Coordenadas XY); esta pantalla proporciona la información del sistema de coordenadas asignado al archivo.  
 

  

 
Haga “clic” en las restantes pestañas para explorar su contenido; a continuación, presione Aceptar.  
 

5. Crear un archivo nuevo  
 
Una de las funcionalidades principales de ArcCatalog es la creación de nuevos archivos de datos en cualquiera 
de los formatos gestionados por ArcGIS. A continuación, se procederá a crear un archivo “shape” de polígonos 
vacío que se utilizará, posteriormente, en unos de los ejercicios relativos al capítulo de edición.  
 
Cierre la carpeta Am_Geografia  haciendo “clic” con el botón izquierdo del ratón en el signo menos (-) situado 
a la izquierda de la misma.  
 
Seguidamente, repita la operación sobre el signo más (+) ubicado a la izquierda de la carpeta denominada 
Cartografía Organización. A continuación, desplace el cursor hasta un punto cualquiera de la ventana situada 
a la derecha de la vista, y haga “clic” con el botón derecho del ratón para abrir el menú de opciones.  
 
Clic derecho luego seleccione New ► Folder (Nuevo ► Carpeta). PRACTICAS 
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Vamos a crear archivos shapefile de puntos, líneas y polígonos en la carpeta PRACTICAS 
Marco la carpeta PRACTICAS, clic derechos, Seleccione New ► Shapefile (Nuevo ► Shapefile).  
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En el cuadro de diálogo desplegado escriba parcelas en la casilla destinada a albergar el nombre del archivo; 
en Feature Type (Tipo de Entidad) seleccione Polygon (Polygon) y haga “clic” en Edit (Editar) para asignar la 
proyección  
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En el cuadro de diálogo desplegado, presione el botón Import (Importar), busque en la carpeta del curso el 
subdirectorio Am_Areas Protegidas, y marque el primer archivo de la lista: Am_Bosques Protectores. Haga 
“clic” en Add (Añadir) para asignar la proyección de éste archivo al archivo nuevo.  
 

 

 
Presione Aceptar en el cuadro de diálogo de la referencia espacial y marque OK (Aceptar) en la pantalla de 
creación del archivo.  
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El archivo de polígonos recién creado, denominado parcelas, que aún no contiene información, será utilizado 

en un ejercicio posterior, en el curso del cual se procederá a incorporar elementos al mismo. 
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EN ESTE EJERCICIO EL USUARIO SE FAMILIARIZA CON LA INTERFAZ DE ARCCATALOG, Y APRENDE A UTILIZAR 
LAS PRINCIPALES HERRAMIENTAS QUE ARCGIS OFRECE PARA EXPLORAR, ABRIR Y ADMINISTRAR LOS DATOS 
QUE GESTIONA. ADEMÁS, SE TOMA CONTACTO CON LOS DISTINTOS TIPOS DE ARCHIVO MANEJADOS POR 
LA APLICACIÓN, Y SE APRENDE A CREAR UN ARCHIVO “SHAPE” NUEVO Y A MANEJAR EL EDITOR DE 
METADATOS. 
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EJERCICIO 1B – INTERFAZ DE ARCMAP 
 
ArcMap es el módulo de ArcGIS diseñado para realizar todas las tareas SIG, que incluyen la visualización, 
consulta, análisis y presentación de los datos geográficos. En este ejercicio se ejecutarán tareas básicas 
dirigidas a familiarizar al alumno con la interfaz de ArcMap.  
 
 
SUMARIO 
 
1. Iniciar ArcMap y abrir un fichero existente.  
2. Cambiar el nombre del Marco de Datos (“Data Frame”) y de las Capas (“Layers”).  
3. Abrir las propiedades del Marco de Datos (“Data Frame”).  
4. Desplegar las fuentes de datos.  
5. Manejar la barra de herramientas.  
6. Consultar los datos.  
7. Explorar la tabla de atributos.  
8. Guardar el mapa. 
 
 
 
1. Iniciar ArcMap y abrir un fichero existente.  
Haga “clic” en el icono de la aplicación de ArcMap o, desde el menú Inicio de Windows, seleccione “Programas 
► ArcGIS ► ArcMap”. Se despliega la interfaz de entrada a la aplicación ArcMap. Haga “clic” con el botón 
izquierdo del ratón en la opción Clase 1: (Un mapa existente:). Presione OK (Aceptar). 

 

Se despliega un mapa de la Clase 1 donde se pueden observar una ortofoto y archivos shp que contienen 

información de la parroquia Chiguaza 
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2. Cambiar el nombre del Marco de Datos (“Data Frame”) y de las Capas (“Layers”).  
El Marco de Datos (“Data Frame”) es el contenedor de las Capas (“Layers”); por defecto, el Marco de Datos 

aparece identificado con la palabra Layers cuando se inicia una sesión de ArcMap. A continuación, se 

procederá a cambiar el nombre por defecto del Marco de Datos que figura en el documento del ejercicio por 

uno más adecuado a la información que contiene. 

 
Sitúe el cursor del ratón sobre la palabra Layers; seguidamente, haga un único “clic” con el botón izquierdo 
del ratón en la posición indicada para que el cursor adopte la configuración de modo de escritura, y substituya 
la palabra Layers por la expresión Capacitación.  
 

  

 
Para renombrar el primero de los archivos listado en el Marco de Datos, sitúe el cursor del ratón sobre el 
nombre actual del mismo (Comunidades) y haga un único “clic” nuevamente con el botón izquierdo del ratón 
para cambiar el cursor al modo de escritura; a continuación escriba la palabra Propietarios.  
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Repita el procedimiento con el segundo archivo, correspondiente a los parcelas. Haga un único “clic” sobre el 
nombre que lo identifica (parcelas), para configurar el cursor en modo de escritura, y renombre el archivo con 
la palabra Fincas.  
 

3. Abrir las propiedades del Marco de Datos (“Data Frame”).  
El Marco de Datos (“Data Frame”) posee propiedades importantes a considerar, tales como la escala y las 
unidades de despliegue de los datos, el sistema de proyección y la escala de referencia, entre otros. A 
continuación se aprenderá como configurar dichas propiedades.  
Coloque el cursor sobre el nombre del Marco de Datos (Capacitación ) y haga “clic” con el botón derecho del 
ratón para desplegar las opciones de su menú contextual; seleccione Properties… (Propiedades…).  

 

 
Haga “clic” en las distintas pestañas del cuadro de diálogo desplegado para explorar la información que 
contiene.  
 
Haga “clic” en la pestaña Coordinate System (Sistema de Coordenadas). ¿Cuál es el sistema de proyección de 
éste marco de datos?_______________________________  

Presione Aceptar cuando finalice la revisión de las propiedades del Marco de Datos.  
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4. Desplegar las fuentes de datos.  
Haga “clic” en la pestaña Source (Fuente), localizada en la parte inferior de la Tabla de Contenido, para 
consultar la ubicación de los archivos que está utilizando.  
 

 

Esta opción es útil para verificar las rutas donde se almacenan los archivos utilizados en un documento de 

ArcMap. 

 
5. Manejar la barra de herramientas.  
Haga “clic” con el botón izquierdo del ratón sobre el botón Zoom in (Zoom de Acercamiento) para realizar un 
acercamiento a una zona determinada del mapa. Utilice la herramienta Pan (Desplazarse) para moverse hacia 
otro sector de la pantalla. Haga “clic” en el botón Full Extent (Extensión Completa) para volver a visualizar 
toda la información. Practique con estas herramientas para familiarizarse con su utilización.  
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6. Consultar los datos.  

Cargar la capa de Cobertura Vegetal2018_MAE   

 
 
Haga “clic” con el botón izquierdo del ratón sobre el botón Identify (Identificar) para consultar los datos 
descriptivos. Una vez seleccionada la herramienta, pulse sobre un polígono del archivo Cobertura 
Vegetal2018_MAE para acceder a los datos de la entidad.  
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7. Explorar la tabla de atributos.  
Haga “clic” con el botón derecho del ratón sobre el nombre del archivo Cobertura Vegetal2018_MAE. En el 
menú desplegado, seleccione Open Attribute Table (Abrir Tabla de Atributos). Recorra la tabla para explorar 
su contenido.  

 

 
Cierre la tabla pulsando sobre el aspa recuadrada en color rojo situada en la esquina superior derecha de la 
misma  
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8. Guardar el mapa.  
Mediante la opción File ► Save (Archivo ► Guardar) se cierra el documento guardando los cambios 
realizados.  
 
 
CON ESTE EJERCICIO EL USUARIO SE FAMILIARIZA CON LA INTERFAZ DE ARCMAP, APRENDE A CONSULTAR 

Y RENOMBRAR EL MARCO DE DATOS Y DE LAS CAPAS, EXPERIMENTA EL MODO DE ACCEDER A LAS FUENTES 

DE DATOS Y APRENDE A DESPLEGAR LA INFORMACIÓN ALMACENADA DE LA TABLA DE ATRIBUTOS DE UN 

ARCHIVO.  

 



MANUAL DE EJERCICIOS ARCGIS 10.5 
 

Manual  de trabajo práctico con ArcGis 10.5  
Ing. Anabel Pérez  
  44 
 

 

TEMA 2 

MÉTODOS DE SELECCIÓN 

 
EJERCICIO 2A – SELECCIÓN POR LOCALIZACIÓN.  
En este ejercicio se utilizan las herramientas de consulta de datos de un archivo con respecto a otro. El objetivo 

del análisis del ejemplo propuesto se centra en determinar cuáles de las ortofotografías de Castilla y León 

disponibles cubren la Provincia de Zamora. 

SUMARIO  
1. Iniciar ArcMap.  
2. Crear una consulta.  
3. Definir un archivo de selección.  
4. Selección interactiva.  
5. Selección por localización.  
 

1. Iniciar ArcMap.  
Haga “clic” en el icono de ArcMap o, desde el menú Inicio de Windows, seleccione “Programas ► ArcGIS ► 
ArcMap”.  
 
Se despliega la aplicación de ArcMap. Marque la opción An existing map: (Un mapa existente:) y desplácese 
por el directorio del curso \Mis documentos\Curso Capacitación CONFENIAE, hasta localizar el proyecto Clase 
2.mxd, sobre el que debe hacer doble “clic” con el ratón. Se despliega la interfaz de ArcMap.  
 

 

 

El proyecto cargado muestra las dos siguientes capas:  
Cobertura Vegetal2018_MAE: archivo vectorial de polígonos que representa la cobertura de uso del suelo de 
la Amazonia.  
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Usted procederá a crear una consulta sobre el contenido de la tabla de atributos en COBERTURA 0 – Bosque 

Nativo y Aceptar 

  

2. Crear una consulta.  
Le han solicitado que proporcione información sobre el cubrimiento de ortofotos existentes para la Provincia 
de Zamora. Para ello, usted creará una consulta sobre el cubrimiento de ortofotos existentes para toda la 
comunidad autónoma de Castilla y León, y posteriormente hará una intersección de tal malla con el territorio 
correspondiente a la provincia de Zamora.  
 
Coloque el cursor en el nombre del archivo Cobertura Vegetal2018_MAE y haga “clic” con el botón derecho 
del ratón para desplegar la lista de opciones. Seleccione Properties (Propiedades). Marque la pestaña 
Definition Query (Definición de consulta).  
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Haga “clic” en el botón Query Builder… (Constructor Consultas…), para desplegar el cuadro de diálogo 
correspondiente. En la ventana superior, haga doble “clic” en el campo Cobertura0 , haga “clic” en el botón 
rotulado con el signo = (igual), pulse el botón Get Unique Values (Obtener Valor Único) para desplegar la lista 
de atributos disponibles, y haga doble “clic” en la expresión ND (No Disponible) de la ventana de la derecha.  

 

 
La consulta debe quedar formulada tal como se muestra debajo de este párrafo.  

 

 

 
Haga “clic” en el botón OK (Aceptar) del cuadro de diálogo Query Builder (Constructor de Consultas) y repita 
la operación en el cuadro de diálogo Definition Query (Definición de Consulta) para ejecutar la selección. 
Observe que ahora usted sólo visualiza en el mapa las ortofotos disponibles.  



MANUAL DE EJERCICIOS ARCGIS 10.5 
 

Manual  de trabajo práctico con ArcGis 10.5  
Ing. Anabel Pérez  
  47 
 

 

 
3. Definir un archivo de selección.  
Para definir un archivo de selección, haga “clic” en el botón  List by Selection (Selección) situada en la parte 
superior izquierda de la Tabla de Contenidos. De clic derecho en la capa que desea se haga la selección y escoja 
Make this only select layer; esto significa que las selecciones se harán sólo sobre este archivo. Haga “clic” en 
el botón List by drawin order, para volver a la visualización anterior.  
 

  

 

4. Selección interactiva.  

Marque el botón de selección interactiva Select Features (Seleccionar Entidades)   y haga “clic” 
con el botón izquierdo del ratón en la Provincia Amazónicas y seleccione la provincia de Pastaza . Su perímetro 
cambiará de color, lo que significa que se ha seleccionado esta entidad de la capa.  
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En este caso usted sólo seleccionará la provincia de Zamora; no obstante, manteniendo presionada la tecla 

“Shift” del teclado del ordenador mientras pulsa el botón arriba indicado, usted puede seleccionar más de un 

elemento espacial en forma interactiva. 

 
Vuelva a hacer “clic” en el botón List by Selection (Selección), en la parte superior izquierda, y marque 
nuevamente los dos archivos que se muestran. Haga “clic” en el botón List by drawin order, para volver a la 
visualización anterior.  
 

  
 
 
5. Selección por localización.  
Cargar el shp de ríos Am_rios_l_50k.shp 
Cargar el shp de Provincias_Amazonicas 
 
A continuación usted utilizará la selección por localización para seleccionar el cubrimiento de ortofotos, en la 
provincia seleccionada.  
 
Haga “clic” en el menú Selection (Selección) y marque la opción Select by Location… (Selección Por 
Localización…).  
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En el cuadro de diálogo desplegado, marque en la ventana superior el archivo Am_rios_l_50k.shp como el 
archivo sobre el cual se ejecutará la selección.  
 
Seleccione intersect (intersecan) como la función que se ejecutará.  
 
Seleccione el archivo Provincias Amazonia en el cual está seleccionada la provincia de Pastaza.  

Presione OK (Aceptar) para ejecutar la selección. Observe que se han seleccionado aquellas ortofotos 
existentes, correspondientes a la provincia de Zamora.  

  
 
  
 
Abra la tabla de atributos haciendo “clic” con el botón derecho del ratón sobre el nombre del archivo 
Am_rios_l_50k.shp en la opción Open Attribute Table (Abrir Tabla de Atributos).  
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Se han seleccionado 28403 registros. Haga “clic” en la pestaña Selected (Seleccionados) para visualizar en la 
tabla sólo los registros seleccionados  

 
 
 
EN ESTE EJERCICIO SE APRENDE A UTILIZAR LOS DISTINTOS MÉTODOS DE SELECCIÓN, Y SE EJECUTA LA 
SELECCIÓN DE ELEMENTOS DE UN ARCHIVO CON RESPECTO A UN CRITERIO BASADO EN LA SELECCIÓN DE 
ELEMENTOS DE OTRO ARCHIVO.  
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EJERCICIO 2B – SELECCIÓN POR CRITERIO DE DISTANCIA 
  
En este ejercicio usted utilizará el menú de selección por atributos y por localización para determinar los 
núcleos de población que quedan próximos a las carreteras representadas en el mapa. 
 
SUMARIO  
1. Abrir un documento en ArcMap.  
2. Selección por atributos.  
3. Selección por criterio de distancia.  
4. Crear un archivo “shape” con la selección.  
 
 
1. Abrir un documento en ArcMap.  
Si no ha salido de la aplicación haga “clic” en el menú File ► Open… (Archivo ► Abrir…). De lo contrario, haga 
“clic” en el icono de la aplicación de ArcMap o, desde el menú Inicio de Windows, seleccione Programas ► 
ArcGIS ► ArcMap.  
En la pantalla de opciones desplegada, seleccione el documento Clase 2.mxd ubicado en el directorio del 
curso.  
Cargar la red vial Am_vias_l.shp  
Cargar poblados y comunidades Am_pobladosIGM2012.shp 
Se despliega la información de carreteras y núcleos de población correspondientes a la región Amazónica. 
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2. Selección por atributos.  
Usted utilizará la selección por atributos para seleccionar las carreteras correspondientes a la categoría “Red 
de Interés General del Estado” y luego hará una selección por localización para determinar aquellas 
localidades que están a una distancia inferior de 500 metros de estas vías.  

 Haga “clic” en el menú Selection (Selección) y marque la opción Select By Attributes… (Selección Por 
Atributos…).  
 

 
 
Seleccione Am_vias_l.shp como el archivo sobre el cual se ejecutará la selección.  
 

 Haga doble “clic” en el campo denominado hct_descrip, haga “clic” en el signo =, y haga “clic” de nuevo 
sobre el botón Get Unique Values (Obtener Valor Único) para desplegar la lista de atributos disponibles. 
Seleccione RUTA PRIMARIA  haciendo doble “clic” en dicho ítem en la ventana de la derecha.  
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La consulta debe quedar formulada tal como se muestra a continuación.  

 
 
 
 
 
Presione OK (Aceptar) para ejecutar la selección. Las carreteras seleccionadas se destacan en color CELESTE.  
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3. Selección por criterio de distancia.  
Haga “clic” en el menú Selection (Selección) y marque la opción Select by Location… (Selección por 
localización…).  
 
Seleccione el archivo vectorial de puntos Am_pobladosIGM2012 marcando la casilla situada a la izquierda del 
mismo.  
Seleccione debajo del recuadro donde se listan los archivos del proyecto la opción Am_vias_l (Use la selección 
de vías primarias) y luego seleccionar APPLY A SERACH DISTANCE  como la condición que se debe cumplir a 
500m.  

 
 
Verifique que esté seleccionado como el archivo a partir del cual se definirá la distancia de 500 metros.  
 
En la ventana de la distancia escriba 500 y, en la unidades de medida, seleccione Meters (Metros).  
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Presione OK (Aceptar) para ejecutar la operación. La selección realizada se refleja en el mapa tal como se 
muestra en la siguiente imagen.  
 
 

 
 
 
 
3. Crear un archivo “shape” con la selección.  

 
En la Tabla de Contenido (recuadro situado a la izquierda de la pantalla), haga “clic” con el botón derecho del 
ratón sobre el nombre del archivo Am_pobladosIGM2012 y seleccione la opción Data ► Export Data (Datos 
► Exportar Datos).  

 

 

 



MANUAL DE EJERCICIOS ARCGIS 10.5 
 

Manual  de trabajo práctico con ArcGis 10.5  
Ing. Anabel Pérez  
  57 
 

 
En el cuadro de diálogo desplegado, haga “clic” en el botón del fichero para seleccionar el directorio donde 
guardará el archivo. Busque en el directorio del curso el subdirectorio \Cartografía Organización\PRACTICAS; 
asigne como nombre del archivo Poblados 500m y presione Save (Guardar) y OK (Aceptar).  
 

   

 

 
Conteste Sí a la pregunta para incorporar el archivo a la aplicación. Hacer “clic” en el botón de eliminar 
cualquier selección para visualizar el archivo incorporado.  
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Haga “clic” con el botón derecho del ratón en la Tabla de Contenido sobre el archivo creado y seleccione Open 
Attribute Tabla (Abrir Tabla de Atributos). Observe que la tabla contiene las 18 localidades que se 
seleccionaron.  

 

EN ESTE EJERCICIO SE APRENDE A UTILIZAR EL MÉTODO DE SELECCIÓN POR CRITERIO DE DISTANCIA DE 
LÍNEAS CON RESPECTO A PUNTOS.  
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EJERCICIO 2C – ASIGNACIÓN DE DATOS POR LOCALIZACIÓN. 
  
La asignación de datos por localización permite incorporar a la tabla de atributos de un archivo de puntos los 
datos almacenados en un archivo de polígonos, en base a la localización de los puntos dentro de los polígonos. 
En el presente ejercicio se asignará a la tabla de atributos de los postes de la red de tendido eléctrico de la 
provincia de Valladolid un nuevo campo con información sobre el estado erosivo de los suelos sobre el cual 
estos se ubican. Después de asignar los datos, se cuantificarán los postes según grados de erosión, al objeto 
de identificar cuántos de los mismos están ubicados sobre suelos clasificados con alto grado de erosión. 
 
SUMARIO  
1. Abrir un documento de ArcMap.  
2. Asignar los datos por localización.  
3. Abrir la tabla y verificar el resultado.  
4. Efectuar el sumatorio del número de postes del tendido eléctrico.  
5. Seleccionar los postes ubicados en suelos con alto grado de erosión.  
 
 
1. Abrir un documento de ArcMap.  
Si no ha salido de la aplicación, desde File (Archivo) seleccione Open (Abrir), al objeto de acceder a un 
documento existente. De lo contrario, haga “clic” en el icono de la aplicación de ArcMap, o desde el menú 
Inicio de Windows, seleccione “Programas ► ArcGIS ► ArcMap”.  
 
En el cuadro de diálogo desplegado, seleccione el fichero 2c.Asignacion de datos por localizacion.mxd, 
ubicado en el directorio del curso. Se abre un documento que contiene dos archivos, uno de puntos, que 
representan postes del tendido eléctrico, y otro de polígonos, que representan los tipos de suelos de la 
provincia de Valladolid tipificados según grados de erosión.  
 

 
 
 
2. Asignar los datos por localización.  
Haga “clic” con el botón derecho del ratón sobre el archivo de tendidos eléctricos BCR10_Tendido_P y 
seleccione la opción Join and Relates ► Join… (Uniones y Relaciones ► Unión…).  
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En el cuadro de diálogo desplegado, cambie la primera opción por Join data from another layer based on 
spatial location (Unir datos desde otra capa basándose en localización espacial).  

 
 
 
En el Punto 1 del cuadro de diálogo en que se está trabajando, Choose the layer to join to this layer, or load 
spatial data from disk: (Elegir capa a unir a esta capa, o cargar datos espaciales desde disco:), seleccione el 
archivo VA_Estados_Erosivos_ED50_UTM30.  
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En la parte inferior del cuadro de diálogo, avance hasta el final de la ruta y reemplace el nombre del archivo 
asignado por defecto por el siguiente: Join_Tendido_Estados_Erosivos.shp. Seguidamente, presione el botón 
OK (Aceptar).  
 
 

 
 
 
3. Abrir la tabla y verificar el resultado.  
Haga “clic” con el botón derecho del ratón sobre el archivo resultante y seleccione la opción Open Attribute 
Table (Abrir Tabla de Atributos).  
 
Desplácese por la tabla hasta la última columna y recorra la tabla de arriba abajo; observe que todos los 
campos de la tabla de atributos del archivo relativo a los estados erosivos se han incorporado en la tabla del 
fichero que almacena los puntos que representan los postes de los tendidos eléctricos.  
 
 



MANUAL DE EJERCICIOS ARCGIS 10.5 
 

Manual  de trabajo práctico con ArcGis 10.5  
Ing. Anabel Pérez  
  62 
 

 
 
 
4. Efectuar el sumatorio del número de postes del tendido eléctrico.  
Se desea ahora conocer cuántos postes se corresponden con cada uno de los diferentes grados de erosión 
tipificados. Haga “clic” con el botón derecho del ratón en el campo GRADO y seleccione la opción Summarize… 
(Resumir…).  

 
 
En el Punto 2 del cuadro de diálogo desplegado, marque la casilla EROSION ► First (EROSION ► Primero), 
para que ésta información quede igualmente incorporada en la tabla de salida.  
 
En la parte inferior de este mismo cuadro de diálogo, desplace el cursor hasta el final de la ruta y reemplace 
el nombre del archivo de salida incorporado por defecto por este otro: VA_Tendido_Grados_Erosivos.dbf.  
 
Presione OK (Aceptar). Se genera una nueva tabla en el subdirectorio indicado en el Punto 3. 
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Haga “clic” en Sí para agregar la tabla resultante en el proyecto donde se está trabajando  

 

 
Cierre la tabla Join_Tendido_Estados_Erosivos.shp y, en la Tabla de Contenido, haga “clic” con el botón 
derecho del ratón sobre la nueva tabla creada (VA_Tendido_Grados_Erosivos.dbf); seleccione Open (Abrir) 
para visualizar la información almacenada en dicha tabla.  

 

El campo Count_GRADO señala la cantidad de postes existentes por cada tipo de grado de erosión; 

adicionalmente, se muestra la pérdida de suelo estimada para cada una de las categorías definidas. 

 

5. Seleccionar los postes ubicados en suelos con alto grado de erosión.  
Ahora usted procederá a seleccionar los postes que se ubican en suelos con alto grado de erosión.  

 Cierre la tabla VA_Tendido_Grados_Erosivos. Coloque el cursor en el nombre del archivo 
Join_Tendido_Estados_Erosivos y haga “clic” con el botón derecho del ratón para desplegar la lista de 
opciones. Seleccione Properties… (Propiedades…). Marque la pestaña Definition Query (Definición de 
Consulta).  
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Haga “clic” en el botón Query Builder (Constructor Consultas…) para desplegar el cuadro de diálogo 
correspondiente. En la ventana de la derecha, haga doble “clic” en el campo “GRADO”, haga “clic” en el signo 
= y haga doble “clic” en la expresión „Alto’, en la ventana de la derecha.  

 

La consulta debe quedar formulada tal como se muestra en la figura incluida a continuación:  

 

 
Haga “clic” en OK (Aceptar) y luego en el botón Aceptar para ejecutar la selección. Observe que ahora usted 
sólo visualiza en el mapa los postes que se ubican en suelos con alto grado de erosión.  
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CON ESTE EJERCICIO SE APRENDE A UTILIZAR LA OPCIÓN DE UNIR DATOS EN LA TABLA DE ATRIBUTOS DE 
UN ARCHIVO DE PUNTOS, EN BASE A LA LOCALIZACIÓN DE LOS MISMOS CON RESPECTO A UN ARCHIVO DE 
POLÍGONOS. ESTA TAREA PERMITE DISCRIMINAR LOS PUNTOS QUE CUMPLEN CON UN CRITERIO DE 
SELECCIÓN ESTABLECIDO EN BASE A LA INFORMACIÓN INCORPORADA EN LA TABLA DE POLÍGONOS.  
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EJERCICIO 2D – HIPERVÍNCULO.  
En este ejercicio se utilizará la herramienta “Hipervínculo” para crear un enlace entre los logotipos y las 

fotografías correspondientes a los espacios naturales protegidos existentes en la Comunidad Autónoma de 

Castilla y León, desde el fichero de polígonos en el que éstos se hallan representados. 

SUMARIO  
1. Abrir el documento.  
2. Configurar el hipervínculo.  
3. Ejecutar el hipervínculo.  
4. Ejecutar otro hipervínculo (opcional).  
 

1. Abrir el documento.  
 Si no ha salido de la aplicación, desde File (Archivo) seleccione Open (Abrir) para acceder a un documento 

existente. De lo contrario, haga “clic” en el icono de la aplicación de ArcMap o, desde el menú Inicio de 
Windows, seleccione “Programas ► ArcGIS ► ArcMap”. En el cuadro de diálogo desplegado, seleccione el 
documento Clase 2 en el directorio del curso.  
Donde se despliega las capas y de poblados, con el botón de  Identify (Identificar) identificar una comunidad 
y generar un hipervínculo. 
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Se despliegan dos capas, una de las cuales almacena información sobre los espacios naturales de la comunidad 

autónoma de Castilla y León incluidos en la REN (Red de Espacios Naturales Protegidos). 

 
2. Configurar el hipervínculo.  

 Coloque el cursor sobre el polígono denominado “Sierra de Ancares” situado al noroeste de la provincia de 
León. Haga “clic” con el botón de consulta interactiva Identify (Identificar) sobre este polígono para desplegar 
la información relativa a ésta entidad.  
 

 

 

 
En la ventana de arriba del cuadro de diálogo desplegado, haga “clic” con el botón derecho del ratón sobre el 
nombre de la entidad, y seleccione la opción Add Hyperlink… (Añadir Hipervínculo…).  

  

 

En la ventana Link to a Document (Enlace a un documento) haga clic en la botón de la izquierda para abrir el 
listado de directorios; en el listado desplegado, busque la carpeta Logos_Fotos_REN\Sierra de Ancares, y 
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seleccione el primer archivo contenido en esta carpeta. Presione Abrir, y pulse a continuación el botón OK 
(Aceptar); finalmente, cierre la ventana de la consulta.  

 

 

3. Ejecutar el hipervínculo.  

1. En la interfaz de ArcMap, haga “clic” con el botón izquierdo del ratón sobre el botón Hiperlinks 

(Hipervínculo)  que, tras las operaciones anteriores, se mostrará activado (rayo de color amarillo); las 
líneas que bordean los distintos espacios naturales se colorearán en azul. Haga “clic” en la entidad Sierra de 
Ancares para visualizar las imágenes vinculadas. Si el visualizador de imágenes desplegado le permite pasar 
de una imagen a otra de la misma carpeta, haga “clic” sobre el botón correspondiente para cambiar de 
imagen.  
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4. Configurar otro hipervínculo (opcional).  
Si dispone de tiempo, configure nuevos hipervínculos a otros espacios naturales protegidos; puede abrir el 
explorador de Windows y buscar en el directorio del curso la carpeta denominada “Logos_Fotos_REN” para 
saber cuáles áreas protegidas poseen información para vincular.  
 

 

EN ESTE EJERCICIO SE APRENDE A CREAR HIPERVÍNCULOS DESDE LA HERRAMIENTA DE CONSULTA DE 
ATRIBUTOS.  
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TEMA 3 

HERRAMIENTAS DE GEOPROCESAMIENTO 

 
EJERCICIO 3A – CORTE DE POLIGONOS.  
En este ejercicio usted trabajará con las herramientas que ofrece ArcMap de geoprocesamiento para cortar 

capas a un área específica. 

Se limita la información de una capa a un área especifico, de acuerdo a un molde, se trabaja con líneas, puntos 

y polígono. 

SUMARIO  
1. Abrir un documento de ArcMap.  
2. Cargar la capa de cobertura vegetal del año 2008   
3. Realizar un corte con el cantón Huamboya 
 

 
1. Abrir un documento de ArcMap  
Si no ha salido de la aplicación, haga “clic” en el menú File ► Open (Archivo ► Abrir), para acceder a un 
documento existente. De lo contrario, haga “clic” en el icono de la aplicación de ArcMap o, desde el menú 
Inicio de Windows, seleccione “Programas ► ArcGIS ► ArcMap”.  
 
En la pantalla de opciones desplegada, seleccione el documento Clases 2.mxd ubicado en el directorio del 
curso.  
Cargar la capa Cobertura Vegetal2018_MAE y realizar un corte con el límite de la nacionalidad para lo cual,  
Seleccionar las herramientas de GEOPROCESSING y dar clic en CLIP  

 
 
O por la caja de herramientas ArcToolbox 
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En la tabla de clip en Input Features colocar la capa de la que se quiere extraer información  Cobertura 
Vegetal2018_MAE, el área de corte es el límite de las nacionalidades Clip Feature , es este caso Limite_NAPE 
En Ouput Feature Class, es la carpeta donde se procede a guardar el nuevo archivo con un nombre: 
nape_cobertura2018 
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EJERCICIO 3B – BUFFER.  
En este ejercicio usted trabajará con las herramientas que ofrece ArcMap de geoprocesamiento para generar 

análisis de proximidad de un área específica. 

El buffer analizar distancias y proximidad de líneas, punto y polígono. En esta opción el usuario ingresa el 
radio con el cual va trabajar. 
 

SUMARIO  
1. Abrir un documento de ArcMap.  
2. Cargar la capa de vías   
3. Realizar un buffer de vías a 1000m de distancia 
 

 
1. Abrir un documento de ArcMap  
Si no ha salido de la aplicación, haga “clic” en el menú File ► Open (Archivo ► Abrir), para acceder a un 
documento existente. De lo contrario, haga “clic” en el icono de la aplicación de ArcMap o, desde el menú 
Inicio de Windows, seleccione “Programas ► ArcGIS ► ArcMap”.  
 
En la pantalla de opciones desplegada, seleccione el documento Clases 2.mxd ubicado en el directorio del 
curso.  
Cargar la capa Am_Vias_l y realizar un Buffer de 500m, 1km, 2km de distancia,  Seleccionar las herramientas 
de GEOPROCESSING y dar clic en BUFF  

 
 
O por la caja de herramientas ArcToolbox 
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En la tabla de buffer en Input Features colocar la capa de la que se quiere extraer información  Am_Vias_l,  
En Ouput Feature Class, es la carpeta donde se procede a guardar el nuevo archivo con un nombre: 
Buff_vias500m. 
En DISTANCE colocar 500 y seleccionar en unidades Metros 
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EJERCICIO 3C – INTERSECT.  
En este ejercicio usted trabajará con las herramientas que ofrece ArcMap de geoprocesamiento para 

combinar capas a un área específica. 

 
Se cruzan dos capas generando sólo las áreas comunes. 

SUMARIO  
1. Abrir un documento de ArcMap.  
2. Cargar la capa de deforestación    
3. Realizar un intersect con el límite de la organización 
 

 
1. Abrir un documento de ArcMap  
Si no ha salido de la aplicación, haga “clic” en el menú File ► Open (Archivo ► Abrir), para acceder a un 
documento existente. De lo contrario, haga “clic” en el icono de la aplicación de ArcMap o, desde el menú 
Inicio de Windows, seleccione “Programas ► ArcGIS ► ArcMap”.  
 
En la pantalla de opciones desplegada, seleccione el documento Clases 2.mxd ubicado en el directorio del 
curso.  
Cargar la capa Am_DeforestacionMAE16_18 y realizar un intersect con el límite de la nacionalidad,  
Seleccionar las herramientas de GEOPROCESSING y dar clic en INTERSECT   

  
 
 
O por la caja de herramientas ArcToolbox 
 
 
 
 
En la tabla de Intersect en Input Features colocar la capa de la que se quiere realizar la unión  Limite Sapara 
y Socio Bosque MAE,  
En Ouput Feature Class, es la carpeta donde se procede a guardar el nuevo archivo con un nombre: 
Intersect_SB Sapara. 
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EJERCICIO 3D – ERASE.  
En este ejercicio usted trabajará con las herramientas que ofrece ArcMap de geoprocesamiento para borrar 

un área de una capa específica. 

Una capa le borra su área a otra, se utiliza para polígonos  

 
SUMARIO  
1. Abrir un documento de ArcMap.  
2. Cargar la capa de provincias    
3. Realizar un erase  con el límite de la organización 
 

 
1. Abrir un documento de ArcMap  
Si no ha salido de la aplicación, haga “clic” en el menú File ► Open (Archivo ► Abrir), para acceder a un 
documento existente. De lo contrario, haga “clic” en el icono de la aplicación de ArcMap o, desde el menú 
Inicio de Windows, seleccione “Programas ► ArcGIS ► ArcMap”.  
 
Abrir un nuevo proyecto ArcMap y guardar como Clase.  
Cargar la capa Provincias Amaznomicas  y realizar un erase con el límite de la nacionalidad,  Seleccionar las 
herramientas del ArcToolbox – Analysis Tools - Overlay dar clic en ERASE    

  
 
 
 
 
En la tabla de erase en Input Features colocar la capa de la que se quiere realizar el eliminar un  área   Limite 
Sapara.  
En Ouput Feature Class, es la carpeta donde se procede a guardar el nuevo archivo con un nombre: 
Erase_Sapara. 
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EJERCICIO 3E – MERGE .  
En este ejercicio usted trabajará con las herramientas que ofrece ArcMap de geoprocesamiento para juntar 

capas de un área específica. 

Sirve para juntar dos o más capas en un solo archivo. Se usa para puntos, líneas o polígonos, útiles para 
empalmes 

 
SUMARIO  
1. Abrir un documento de ArcMap.  
2. Cargar la capa de provincias    
3. Realizar un merge  con el límite de la organización 
 

 
1. Abrir un documento de ArcMap  
Si no ha salido de la aplicación, haga “clic” en el menú File ► Open (Archivo ► Abrir), para acceder a un 
documento existente. De lo contrario, haga “clic” en el icono de la aplicación de ArcMap o, desde el menú 
Inicio de Windows, seleccione “Programas ► ArcGIS ► ArcMap”.  
 
Abrir un nuevo proyecto ArcMap y guardar como Clase.  
Cargar la capa Provincias Amazónicas  y realizar un merge con el límite de la nacionalidad. 
Seleccionar las herramientas de GEOPROCESSING y dar clic en MERGE     

  
 
 
 
En la tabla de dialogo de merge  en Input Features colocar la capa de la que se quiere realizar el eliminar un  
área   Limite Kichwa y Provincias Amazónicas.  
En Ouput Feature Class, es la carpeta donde se procede a guardar el nuevo archivo con un nombre: 
Merge_Sapara. 
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EJERCICIO 3F – UNION .  
En este ejercicio usted trabajará con las herramientas que ofrece ArcMap de geoprocesamiento para UNIR 

capas de un área específica. 

La opción unión une a dos polígonos diferentes, creando un nuevo shp, con las mismas características. Para 
la aplicación se activa editor y se procede a Geo procesar 

 
SUMARIO  
1. Abrir un documento de ArcMap.  
2. Cargar la capa de límites de la organización y la capa de áreas socio bosque   
3. Realizar una unión de las dos capas 
 

1. Abrir un documento de ArcMap  
Si no ha salido de la aplicación, haga “clic” en el menú File ► Open (Archivo ► Abrir), para acceder a un 
documento existente. De lo contrario, haga “clic” en el icono de la aplicación de ArcMap o, desde el menú 
Inicio de Windows, seleccione “Programas ► ArcGIS ► ArcMap”.  
 
Abrir un nuevo proyecto ArcMap y guardar como Clase.  
Cargar la capa Socio Bosque  y realizar una unión con el límite de la nacionalidad. 
Seleccionar las herramientas de GEOPROCESSING y dar clic en UNION      

  
 
O por la caja de herramientas ArcToolbox – Analysis Tools  Overlay y seleccionar Unión 
 
 
En la tabla de dialogo de unión en Input Features colocar la capa de la que se quiere realizar el eliminar un  
área   Limite de la organización  y socio bosques.  
En Ouput Feature Class, es la carpeta donde se procede a guardar el nuevo archivo con un nombre: 
Union_OrgSbosque. 
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EJERCICIO 3G – DISSOLVE  .  
En este ejercicio usted trabajará con las herramientas que ofrece ArcMap de geoprocesamiento para Fusionar 

polígonos de una capa de un área específica. 

En este ejercicio es necesario un shape con múltiples divisiones, como por ejemplo las provincias Amazónicas, 
hacer una copia de provincias.  

 
SUMARIO  
1. Abrir un documento de ArcMap.  
2. Cargar la capa de Provincias Amazónicas y crear una copia como Provincias Amazonia2   
3. Realizar un dissolve de los polígonos de la capa 
 

1. Abrir un documento de ArcMap  
Si no ha salido de la aplicación, haga “clic” en el menú File ► Open (Archivo ► Abrir), para acceder a un 
documento existente. De lo contrario, haga “clic” en el icono de la aplicación de ArcMap o, desde el menú 
Inicio de Windows, seleccione “Programas ► ArcGIS ► ArcMap”.  
 
Abrir un nuevo proyecto ArcMap y guardar como Clase.  
Cargar la capa Provincias Amazonicas2  y realizar un dissolve los polígonos de la división política de las 
provincias de la Amazonia . 
Seleccionar las herramientas de GEOPROCESSING y dar clic en DISSOLVE    
    

  
 
O por la caja de herramientas ArcToolbox – Analysis Tools  Overlay y seleccionar Dissolve 
 
 
En la tabla de erase en Input Features colocar la capa de la que se quiere realizar el eliminar un  área   Limite 
de la organización  y socio bosques.  
En Ouput Feature Class, es la carpeta donde se procede a guardar el nuevo archivo con un nombre: 
Union_OrgSbosque. 
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EJERCICIO 3H – JOIN  
En este ejercicio usted trabajará con las herramientas que ofrece ArcMap pegar tablas de atributos con una 

capa según la relación espacial. 

Se pegan columnas de una tabla otra según la relación espacial entre las dos capas. 

 
SUMARIO  
1. Abrir un documento de ArcMap.  
2. Cargar la capa de poblados panzaleo   
3. Realizar un Join con la tabla de atributos de Excel 
 

1. Abrir un documento de ArcMap  
Si no ha salido de la aplicación, haga “clic” en el menú File ► Open (Archivo ► Abrir), para acceder a un 
documento existente. De lo contrario, haga “clic” en el icono de la aplicación de ArcMap o, desde el menú 
Inicio de Windows, seleccione “Programas ► ArcGIS ► ArcMap”.  
 
Abrir un nuevo proyecto ArcMap y guardar como Clase.  
Cargar la capa Poblados Panzaleo  y realizar un Join con la tabla de atributos de Excel. 
Clic derecho en la capa poblados y seleccionar Join    
    

  
 
Se realizara el Join con la tabla Excel 
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TEMA 4 

SUBIR PIUNTOS GPS AL ARCGIS 
 

En este ejercicio usted trabajará con las herramientas que ofrece ArcMap para subir archivos Excel con 

coordenadas y generar archivos shp. 

 
SUMARIO  
1. Abrir un documento de ArcMap.  
2. Georreferenciar un predio y apuntar las coordenadas en una tabla Excel 
3. Subir las coordenadas Excel en el ArcMap 
 

1. Abrir un documento de ArcMap  
Si no ha salido de la aplicación, haga “clic” en el menú File ► Open (Archivo ► Abrir), para acceder a un 
documento existente. De lo contrario, haga “clic” en el icono de la aplicación de ArcMap o, desde el menú 
Inicio de Windows, seleccione “Programas ► ArcGIS ► ArcMap”.  
 
Abrir un nuevo proyecto ArcMap y guardar como Clase.  
Georreferenciar una parcela y sistematizar los datos a una hoja Excel 
 
Coordenadas comedor 
 

 
 
Coordenadas sitios turísticos 
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Luego en el ArcMap ir a FILE – Add Data – y seleccionar Add XY Data  
 
 

 
 
Se despliega el cuadro de dialogo y cargar la información 
Choose a table from the map or browse for another table se debe dar clic en la carpeta amarilla y buscar 
donde se encuentra localizado el archivo Excel, en este caso COMEDOR CONFENIAE y dar doble clic  
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Dar doble clic COMEDOR CONFENIAE y seleccionar la Hoja Excel 1 donde se encuentran los datos y poner Add 

 
 
Automáticamente reconoce coordenadas X Y 
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En Descripción; Unknown Coordinate System  colocar el sistema de Referencia dando clic en Edit  
Luego Proyected Coordinate Systems – UTM - WGS84 - Southern Hemisphere y seleccionar WGS 1984 UTM 
Zona 18S 
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Luego se carga al ArcMap un archivo Excel georreferenciado con las coordenadas como Hoja1$ Events 
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Para transformar en archivo shapefile se debe exportar  
Clic derecho sobre la hoja Excel georreferenciado Hoja1$ Events – Data – Export Data 
Y guardar el archivo en su lugar de almacenamiento como Comedor CONFE 
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TEMA 5 

CAPAS Y SIMBOLOGÍA. 

 
EJERCICIO 3A – MÉTODOS DE CLASIFICACIÓN DE DATOS.  
En este ejercicio usted trabajará con las herramientas que ofrece ArcMap para simbolizar datos cualitativos, 

cuantitativos y en forma de gráficos. 

SUMARIO  
1. Abrir un documento de ArcMap.  
2. Simbología por categorías.  
3. Simbología por cantidades.  
4. Métodos de clasificación de los datos.  
5. Utilizar método de clasificación manual.  
6. Definir valores excluidos.  
7. Cambiar el número de decimales de los valores.  
8. Normalizar los datos.  
9. Simbología por gráficos.  
10. Modificar el tamaño de los gráficos según una variable.  
11. Establecer la escala de referencia.  
 

 
1. Abrir un documento de ArcMap  
Si no ha salido de la aplicación, haga “clic” en el menú File ► Open (Archivo ► Abrir), para acceder a un 
documento existente. De lo contrario, haga “clic” en el icono de la aplicación de ArcMap o, desde el menú 
Inicio de Windows, seleccione “Programas ► ArcGIS ► ArcMap”.  
 
En la pantalla de opciones desplegada, seleccione el documento Clase 2.mxd ubicado en el directorio del 
curso.  
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2. Simbología por categorías.  
 
La posibilidad de establecer una simbología personalizada para un archivo determinado, dependerá de la 
información almacenada en la tabla de atributos de éste, o en otras tablas externas que se pueden enlazar a 
la tabla del archivo.  
En la primera parte de este ejercicio se procederá a asignar un color diferente para cada provincia (clasificación 
por Valores Únicos). En la Tabla de Contenido, haga “clic” con el botón derecho del ratón sobre el nombre del 
archivo denominado Am_DeforestacionMAE16_18 y seleccione Properties… (Propiedades…) en el menú 
desplegado. Marque la pestaña Symbology (Simbología) para asignar la simbología por categoría.  
 

 

 
Haga “clic” en Categories (Categorías); la opción Unique Values (Valores Únicos) debe aparecer seleccionada 
por defecto. En la opción Value Field (Campo con Valores), seleccione TRANSICIÓN. Haga “clic” en Add All 
Values (Añadir Todos Valores) para agregar la lista completa de los nombres de las provincias y asignar un 
color diferente para cada una de ellas. Si la secuencia de colores no le satisface, puede seleccionar otra 
desplegando la lista en Color Ramp (Esquema de Color). Haga “clic” en Aceptar para aplicar los cambios.  
 



MANUAL DE EJERCICIOS ARCGIS 10.5 
 

Manual  de trabajo práctico con ArcGis 10.5  
Ing. Anabel Pérez  
  99 
 

 

 

 
Se despliega el archivo con un color diferente para cada unidad espacial y, en la Tabla de Contenido, aparece 

un listado con la leyenda. 
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3. Simbología por cantidades.  
Ahora procederá a utilizar datos cuantitativos para representar la variabilidad de los mismos. El interés de 

representar estos datos preferiblemente con Colores Graduados, estriba en detectar donde existe más y 

donde existe menos cantidad de un dato en particular. En este ejemplo trabajará con los datos de población 

total de Castilla y León por municipios, referida al año 2005. 

 
Haga “clic” nuevamente en el botón derecho del ratón sobre el archivo CyL_Demografía_2005_ED50_UTM30 
y seleccione la opción Properties… (Propiedades…); la pestaña Symbology (Simbología) debe aparecer 
seleccionada por defecto, debido a su reciente utilización.  
 

 

 
Haga “clic” en Quantities (Cantidades); la opción Graduated colors (Colores graduados) aparecerá 
seleccionada por defecto. En la opción Field ► Value (Campos ► Valor), seleccione POBLACION (los datos 
de población para el año 2005 están almacenados en este campo). Presione Aceptar para visualizar los 
cambios en el mapa.  
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Por defecto, ArcMap establece 5 clases y utiliza el método de Rupturas Naturales de Jenks para agrupar los 

datos. En algunos casos estas opciones pueden no ser las más apropiadas para representar la información. 

Usted probará ahora otros métodos de clasificación para representar los datos de población. 

 

 

 
4. Métodos de clasificación de los datos.  
Haga “clic” con el botón derecho del ratón en el archivo CyL_Demografía_2005_ED50_UTM30 para 
seleccionar la opción Properties… (Propiedades…). La pestaña Symbology (Simbología) se mostrará por 
defecto. Haga “clic” en el botón Classify… (Clasificar…) para modificar el método de clasificación.  
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En la parte superior de la pantalla recién desplegada se visualiza el menú disponible para modificar el método 

de clasificación. Esta nueva pantalla muestra el número de clases y un recuadro con la estadística básica de 

los valores utilizados. En su parte inferior presenta el Histograma de frecuencia de los datos. El histograma es 

de gran utilidad para seleccionar el método de clasificación más adecuado, o elaborar uno en forma manual 

asignando los límites de las clases en forma interactiva 

 
Cambie el método de clasificación a Quantile (Cuantil) y el número de clases a 6 (seis); observe que las clases 
han modificado sus límites en el histograma. Presione OK (Aceptar) y luego Aceptar para visualizar los 
cambios.  
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